
JOURNAL OF DISTANCE EDUCATION

ht
tp
://
de

j.z
jtv
u.
ed

u.
cn

JOURNAL OF DISTANCE EDUCATION

一、研究背景

随着多媒体网络技术特别是 Web 2.0 技术的发展， 网络

教 研日 趋 成 为研 究 热 点。 对 于 国 内 网 络 协 同 教 研， 通 过 文

献 调 研发 现， 近 几年 相 关 研究 主 要 集 中 在 虚 拟 教 研 社 区 的

环境 搭 建， 网络 教 研 学习 共 同 体 的 构 建， 网 络 教 研 的 管 理

与评价等，[1] 对于如何通过区域教师网络协同备课来提升教

师群体教学设计能力的研究则基本没有涉及。 在此背景下，
自 2011 年起， 北京师范大学教育技术研究所和安徽省肥西

县教育局合作， 开展基于学习元 [2] 平台 （http://lcell.bnu.edu.
cn） 的区域网络协同备课， 学习元平台支持教师在线对方案

进行 共 同 研讨、 微 批 注、 评 论 和 协 同 编 辑， 通 过 对 协 同 方

案 的 交流、 讨 论 和修 订， 促 进 每 个 教 师 个 体 和 群 体 教 学 设

计知识的进化和发展。
社 会 网 络 分 析 ( Social Network Analysis，简 称 SNA)源 自

20 世纪 30 年代英国的人类学研究，至今已发展了七十多年 ,
并已 在 社 会学、经 济 学、教 育 学 和心 理 学 等 学 科 领 域 得 到 广

泛运用。 [3]运用社会网络分析方法分析基于网络的虚拟学习

社区和学习共同体成员的行为关系和活动，能够帮助研究者

揭示学习者之间的群体行为现象或群体结构，以及其对个人

和群体发展的影响等。
基于 此， 本 文 借 鉴 社 会 网 络 分 析 方 法， 以 安 徽 省 肥 西

县 10 所小学二年级语文教师协同备课分析为例， 尝试回答

下述 问 题： 教师 协 同 备课 过 程 中 是 否 体 现 了 知 识 的 群 体 建

构？ 教 师 参 与情 况 如 何？ 是 否 体 现 了 角 色 差 异？ 教 师 围 绕

着 备 课内 容， 体 现了 怎 样 的 分 布 特 点？ 为 后 续 协 同 备 课 提

供了怎样的参考？

二、社会网络分析相关文献综述

SNA 以社会行动者及其相互关系为研究内容，并通过描

述行动者间的关系模型，分析这些模型所蕴含的结构以及它

们对行动者和整个群体的影响，因而适合分析学习者之间的

参与特征。 [4]有两种方法可以描述社会网络：关系网络的图形

表达社群图法和矩阵代数方法。 社会网络常见有 1-模网络和

2-模网络之分。 模（mode）指的是行动者的集合，模的数目指

的是网络中社会行动者集合的类型的数目。 如果研究对象仅

仅是一个集合的行动者，研究行动者集合内部各个行动者之

间的关系，这种网络叫做 1 -模网络。 2 -模网络研究两类行

动者群体之间的关系，或者一类行动者和一类事件之间的关

系，也称之为隶属关系数据。 2-模数据可以利用长方形矩阵

来表征，在此基础上可转换为两个 1-模正方阵矩阵，或者 转

换为一个二部 1-模矩阵（bipartite matrix）,只要数据以这种方

阵的形式表达，用来分析 1-模网络数据的方法都可以同样用

来分析该数据。 [5]

利用 社 会 网络 分 析 方 法，可 以 进 行 相 关 中 心 性（包 括 点

度中心度、中介中心 度等）、中 心 势、凝 聚 子 群（包 括 派 系、K-
丛、K-核、成分和块等）、关联性、角色分析和核心—边缘分析

等。 近几年来，国内外研究学者都日益重视社会网络分析方

法的应用。 如对教育博客的分析，包括对苏州教育博客学习

发 展共 同 体、[6]晋江 教 师 研修 网 博 客、[7]新 浪 微 博、[8]教 育 技 术

博 客 和 海盐 教 师 博客 的 社 会网 络 分 析，[9] [10]以 及 虚 拟学 习 社

区的社会网络分析 [11][12]等。 而随着分布式认知、协同知识建构

理论 的 发 展和 协 作 学习、网 络 教研 的 兴 起，社 会 网 络 分 析 方

法为 协 作 交流 模 式、知识 建 构 过程、网 络 教 研 规 律 的 揭 示 提
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供了方法支持，相关学者开展了一系列围绕具体问题的深入

研 究， 如 利用 社 会 网络 分 析 虚拟 学 习 社区 中 意 见 领 袖 的 作

用、[13]分析学生协作学习中的互动行为 [14]和参与度 [15]、基于 社

会网络分析在线协作学习研究、[16]利用社会网络 比 较 在线 和

面对面学习环境下的交流模式、[17]异步网络协作学习中学习

者群体知识建构层次和角色分析、[18]网络协作学习中的互动

网 络 结 构 分 析 [19]和 K12 教 育 虚拟 学 习 社 区 的 知 识 建 构 过 程

和 特 征 [20]等 ；利 用 社 会 网 络 分 析 方 法 ，在 以 “Google group+
Gmail”搭建的网络教研讨论区中发现，相对松散的扁平化交

互结构是讨论区得以扩展的重要结构，[21] 提出了促进教师博

客互动由浅入深的建议，[22] 并尝试构建整合现实网络与虚拟

网络的混合式区域教研协作分析框架等。 [23]

通过文献调研发现， 一方面网络分析应用日趋深入，为

本研究的研究思路、研究方法等都提供了借鉴和参考。 但另

一 方 面，发 现 国 内研 究 主 要聚 焦 在 对博 客 群、讨论 区 等 虚 拟

社区的协作学习和网络教研分析，对于网络协同备课并没有

涉及。 并且，已有研究主要偏重利用社会网络中的 1-模网络

开 展 分析，仅 仅 关注 分 析 对象 间 的 互动 关 系 和结 构，而 对 于

分析对象和事件、分析对象和属性之间的 2-模网络分析基本

鲜有探讨。 由于本研究在分组的基础上开展对教学设计的网

络协 同 备 课，除 了 分 析教 师 间 整体 关 系 外，还 关 注 教师 在 协

同备课过程中小组层次的关系、教师和协同内容之间的深层

次交互关系等，因此，需要将 1-模网络和 2-模网络进行综合

分析，从而能够更好地全面透视协同备课过程中的分布情况

和交互特点。 这也相应构成了本研究的创新点和挑战点。

三、研究设计

（一）研究案例与研究对象

本文研究对象为 2012 年 3~4 月份参与网络协同备课的

肥 西县 10 所 小 学 33 位 二 年 级的 语 文 教 师 及 2 位 参 与 组 织

和讨论的课题研究人员，其中每位教师都具有至少 1 年信息

化环境下开展教学的相关经验。 本次协同备课的网络支撑是

学 习 元 平 台（http://lcell.bnu.edu.cn），先 后 持 续 有 半 个 月 左 右

时间。 在这次协同备课活动中，10 所 小学 两 两 学校 结 对，33
位语文教师共形成 5 个协同备课小组。

（二）研究工具

数据处理工具主要使用 Excel 2007、UCINET 6.0 及 Net-
Draw 2.0。

（三）研究过程

1.确定分析节点

节点为网络协同备课的 33 位语文学科教师、 参与协同

备课讨论的 2 位研究人员，及其协同备课的 5 篇方案。

2.收集网络协同备课数据，进行内容编码

从学习元后台提取本次协同备课的相关数据样本，包括

协同方 案 名 称、编 辑 者、编辑 操 作 类型、相 关 编辑 内 容 等，共

计 308 条分析样本，然后将提取的 308 条分析样本拆分成具

有明确主题的 350 条意义单位。 为了解教师协同备课过程中

意义 单 位 的 知 识 建 构 层 次 和 群 体 知 识 进 化 情 况， 利 用 Gu-
nawardena 分析模型开展编码， 两位研究者独立编码的信度

一致 性 达 到 84%。 为 了 解 教师 在 协 同备 课 过 程中 的 关 注 主

题， 两 位研 究 者 再从 教 学 维度 标 注 每条 意 义 单 位 的 所 属 主

题， 标注时信度一致性达到 86%（涉及的教学设计方面的主

题包括教材分析、教学目标分析等共计 27 个）。 最终在Excel
2007 中形成如下表 1 所示的协同备课编码内容列表， 其中方

案编号“201”表示二年级第一个小组的协同方案。

3.确定 SNA 编码矩阵

（1）建立协同备课人员 2-模关系矩阵及其 1-模矩阵。 在

Excel 2007 中，利用数据透视表功能，形成如下表 2 所示的协

同备课人员参与协同方案的 2-模多值矩阵，数值表示教师参

与方案协同编辑次数。 在此基础上进行二值化处理，形成如

下表 3 所示的 2-模关系矩阵，其中 1 表示教师参与该组方案

的协同备课活动，0 表示没有参与。

为了进一步分析协同备课教师间的关系，在上述 2-模矩

阵基础上，在 Ucinet 6.0 中利用 Data>Affiliations 转化为 1-模

关系矩阵，形成 35×35 矩阵，如下表 4 所示，它表示的是两个

行 动 者（包 括 两 位参 与 协 同备 课 的 课题 研 究 人员）共 同 参 与

同 一 协 同 备 课 小 组 的 次 数，如 教 师“fxydylf”和“fxdgzyy”共 同

对两篇方案进行了修改。

教师区域网络协同备课中的社会网络分析 荨荨理论前沿

表 1 协同备课内容编码列表

编号 方案编号 编辑人员 操作类型
协作知识建构 5

阶段编码
教学维度

1 201 fxljwcy 评论 3E 问题设计

2 201 fxljzrh 修订 2D 识字策略

3 201 fxzphjf 修订 3D 教学目标

… … … … … …

350 205 fxfgwyn 评论 1B 学习方式

表 2 网络协同备课 2-模多值矩阵

201 202 203 204 205

fxdgzyy 2 0 20 5 0

fxydylf 0 1 4 16 1

fxthzh 0 0 0 0 21

… … … … … …

fxzpgyq 1 0 0 0 0

表 3 网络协同备课 2-模二值矩阵

201 202 203 204 205

fxdgzyy 1 0 1 0 0

fxydylf 0 1 1 1 1

fxthzh 0 0 0 0 1

… … … … … …

fxzpgyq 1 0 0 0 0

表 4 协同备课人员 1-模矩阵

fxdgzyy fxydylf Fxthzh … fxzpgyq

fxdgzyy 3 2 0 … 1

fxydylf 2 4 1 … 0

fxthzh 0 1 1 … 0

… … … … … …

fxzpgyq 1 0 0 … 1
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为了利用图论方法来表示 2-模数据， 要在 Ucinet 6.0 中

构 建 相 应 的 二 部 矩 阵（bipartite matrix），此 时 行 动 者 （协 同 备

课 人 员）和 事 件（协同 方 案）都被 看 成 是 点，线 用 来 表 示 行 动

者 到 达 事件 的 关 系（在 行 动 者和 行 动 者 之 间，或 事 件 和 事 件

之间不存在直接的关系）， 这样用来分析 1-模数据的方法都

可用来分析该数据。 [20]最终形成如下表 5 所示的网络协同备

课 二部 矩 阵，该矩 阵 为 40×40 的 正 方 形 矩 阵，在 这 个 二 部 矩

阵中，两个协同备课人员-协同方案块与初始矩阵完全一样，
两个新的矩阵 （协同备课人员-协同备课人员矩阵和协同方

案-协同方案矩阵）编码为 0。

（2）建立“协 同 备课 人 员-知 识 建 构 阶 段”2-模 关 系 矩 阵

及 1-模矩阵。 在 Excel 2007 中，利用数据透视表功能，形成如

下表 6 所 示 的 “协 同 备 课人 员-知 识建 构 阶 段”2-模 关 系 矩

阵，该 矩 阵为 35×13 的 长 方形 矩 阵，显 示 的 为 参 与 协 同 编 辑

人员的编辑内容在知识协同建构各阶段的分布情况。 和表 2
矩阵类似，在此矩阵基础上，从知识建构的角度，可以建立对

应协同备课人员和知识建构阶段的 1-模矩阵、二部矩阵并进

行分析。

（3）建立“协同备课人员-教学维度”2-模关 系 矩 阵及 1-
模矩阵。 在 Excel 2007 中，利用数据透视表功能，形成如下表

7 所示的“协同备课人员-教学维度”2-模关系矩阵，该矩阵为

35×27 的长方形矩阵， 显示的为参与协同编辑人员的编辑内

容在各个讨论主题的分布情况。 需要注意的是“协同备课人

员-教学维度”和“协同备课人员-知识建构阶段” 2-模关系矩

阵均为多值长方形矩阵，同样，在此矩阵基础上，从行和列分

别都可以建立对应的正方形 1-模矩阵、二部矩阵来开展相关

网络分析。

4.社群图及其量化分析

在上述矩阵的基础上， 利用 UCINET 6.0 及 NetDraw 2.0
工具开展量化分析以及可视化的社群图分析，通过对教师协

同备课过程中的网络结构图、中心性、凝聚子群等分析，探讨

在协同备课过程中教师间信息交流次数和关系紧密程度，在

协同备课过程中较为活跃的核心人员和边缘参与人员，以及

协同备课过程中形成的派系等。 并进而分析网络协同备课教

师具有怎样的分层特点， 在知识建构方面具有怎样的倾向，
有哪些教师关注教学设计中的相类同主题等。

四、网络分析结果

（一）网络结构图整体分析

在 UCINET 中，协 同 备 课 2-模 矩 阵（表 2）基 础 上，利 用

NetDraw>File>Open>UCINET dataset>2-Mode Network 工 具生

成相应二部 2-模网络社群图，如下图 1 所示，从 图 中可 以 看

出（图 中 连 线的 粗 线 显示 的 为 教 师 的 参 与 度，下 同），教 师 围

绕 着 5 个 协 同 方案，体 现 了一 定 的 聚 类 性，大 部 分 教 师 都 只

参与其中一个方案的协同修订， 局限于本组内的协同修订。
如将仅参与对一个方案修订的人员去掉，则形成如下图 2 所

示的网络图， 其中参与协同的人员由 35 位减少为 12 位，说

明在协同备课过程中，有 12 位教师不仅关注本组的协同，还

参与对其他组的讨论和协同。

图 1 网络协同备课二部 2-模网络

图 2 参与多组协同 2-模网络

在协同备课人员 1-模关系矩阵的基础上，利用NetDraw>
File>Open>UCINET dataset> Network 工 具生 成 教 师网 络 结 构

图，如下图 3 所示，从协同备课成员的网络图来看，参与协同

Theory Front

表 5 协同备课二部矩阵

fxdgzyy fxydylf fxthzh …

fxdgzyy 0 0 0 …

fxydylf 0 0 0 …

fxthzh 0 0 0 …

… … … … …

205

0

1

1

…

…

…

…

…

…

202

0

1

0

…

fxzpgyq

0

0

0

…

201

1

0

0

…

fxzpgyq 0 0 0 … 0

201 0 0 0 … 0 0 0 0 0

202 0 0 0 … 0 0 0 0 0

… … … … … … … … … …

205 0 0 0 0 0 0 0 0 0

表 6 “协同备课人员-知识建构阶段”2-模关系矩阵

1A 1B 1C 1D

fxdgzyy 0 3 0 0

fxydylf 2 8 1 0

fxthzh 0 6 0 1

… … … … …

2C

4

2

0

…

2B

1

1

1

…

1E

0

0

0

…

2A

0

0

3

…

fxzpgyq 0 1 0 0 000 0

2D

9

1

2

…

0

3B 3C 3D 3E

0 0 10 0

0 1 6 0

0 0 8 0

… … … …

0 0 0 0

表 7 “协同备课人员-教学维度”2-模关系矩阵

板书设计 创新思维培养 … 作业设计

fxdgzyy 1 0 … 0

fxydylf 0 0 … 0

fxthzh 0 0 … 0

… … … … …

fxzpgyq 0 0 0 0
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备课人员之间的内部交互较为均衡，体现了一定的网状结构

和 凝 聚 特性，说 明 在协 同 备 课过 程 中，教师 围 绕 着教 学 设 计

方案的协同交互整体较为密切。 为了进一步可视化参与协同

备课 人 员 之 间 的 聚 类 关 系，采 取 多 维 量 表 (Multi Dimensional
Scaling,MDS)方法把在行动者之间的关系截面表现出来，多维

量 表 技 术是 根 据“距离”进 行 画图 的，在 二维 空 间 中，距 离 越

近的点关系也越紧密，如下图 4 所示，参与协同的 35 位教师

体现了一定的聚类性，在后述内容中还会进一步进行量化深

入分析。

图 3 网络协同备课教师网络

图 4 网络协同备课教师 MDS 网络

（二）中心度分析

1.点度中心度分析

点度 中 心度 是 一 个最 简 单、最具 有 直 观 性 的 指 数，它 表

示与某个行动者有直接关系的行动者或者相关事件的数目，
点度中心度大的行动者居于中心地位，拥有较大的权力。 点

度中心度分析使用 UCINET 的“Network>Centrality>Degree”功

能，首先对表 2 参与协同方案的 2-模多值矩阵的点度中心度

进行计 算，如 下 表 8 中“2-模 矩 阵”列所 示，表 示的 为 教 师参

与各主题的频度，其中排在前十名的为 fxdgzyy、fxydlf、fxthzh、
fxydzy、fxfgwyn、fxmswyz、fxmswh、fxdgfyh、fxxmym 和 fxmslxd 教

师，编号的前面四个字母为区及学校首字母，从中可以发现，
从参与次数来看，这 10 位教师来自其中 6 个学校，分布相对

比 较 均衡，也 说 明从 参 与 次数 来 看，剩下 的 4 所 学 校 教 师 参

与次数略显不足，需要后续重点关注。
而从对协同备课人员的 1-模矩阵的点度中心度计算，如下

表 8 中的“1-模矩阵”列所示，排在前十位的教师为 fxydzy、ktzd1、

fxydylf、fxdgzyy、fxdgfyh、fxzpxy、fxzpyj、ktzd2、fxthzfr 和 fxxmym，
排名和 2-模矩阵有了较大的改变，1-模矩阵的点度中心度显

示相互产生联系的教师频次，这说明有的教师由于参与了多

个协同方案修改，因此，互相产生联系的教师次数更多，这种

教师反而在组间更具有影响力，体现了参与的人际广度。 其

中“ktzd1”和“ktzd2”为课题组指导人员，说明课题组参与人员

虽然参与的次数不多，但是，参与广度较广，对教师协同备课

有着积极的影响。

对表 6“协同备课人员-知识建构阶段”二 值 化处 理 基 础

上， 根 据 其 二 值 矩 阵 获 得 其 二 部 矩 阵 ， 再 使 用 UCINET 的

“Network>Centrality>Degree”进行 点 度 中心 度 计 算，就 可 以 得

出 参 与 各个 阶 段 协同 教 师 人数 和 教 师参 与 的 知 识 建 构 阶 段

数量。对表 7“协同备课人员-教学维度”矩阵进行类似点度中

心度计算，就可以得出参与不同主题讨论的教师人数和每个

主题参与讨论的教师数量。 参与各个阶段知识建构的教师数

量如图 5 所示，从中可以看出，31 位教师在 1B 阶段参与了观

点和想法分享，23 位教师在 2D 阶段提出了自己的替代设计

思路和方法，有 24 位教师在 3D 阶段针对方案提出了达成最

终一致意见的修订结果。 而参与各主题讨论的教师数量分布

如图 6 所示（其他非主题的讨论内容去掉），最多的前 5 个主

题 为 课堂 拓 展 策 略（19 人）、识 字 策 略（19 人）、写 话 策 略（17
人）、课文处理策略（17 人）、课堂导入策略（15 人），说明这些

策略都是教师们的关注焦点，而有些重要主题如学生课堂学

习 方 式 、信 息 技 术 应 用、创 新 思 维 培 养 、评 价 策 略 等 重 要 主

题，参与讨论的教师寥寥无几，出现关注主题集体盲点现象。

图 5 参与各个阶段知识建构的教师数量

教师区域网络协同备课中的社会网络分析 荨荨理论前沿

表 8 协同备课人员网络点度中心度

节点

2-
模

矩

阵

1-
模

矩

阵

节点

2-
模

矩

阵

1-
模

矩

阵

节点

2-
模

矩

阵

1-
模

矩

阵

节点

2-
模

矩

阵

1-
模

矩

阵

fxdgzyy 27 30 fxmslxd 13 9 fxflwyj 8 7 fxfgyl 3 10

fxydylf 22 37 fxzpxy 13 25 fxljwcy 8 14 fxljfwh 3 14

fxthzh 21 10 fxmszcx 12 9 fxxmyxz 8 11 fxljly 3 14

fxydzy 21 51 FX-
THzxx

12 10 fxljwq 7 14 ktzd2 3 24

fxfgwyn 18 10 fxzpyj 12 25 fxljzrh 6 14 fxthzfr 2 21

fxmswyz 18 16 fxbyzp 10 11 FXXMztt 6 11 fxljxj 1 14

fxmswh 17 9 fxbyzh 10 18 fxfgcm 5 10 fxyd-
wgx

1 14

fxdgfyh 16 30 fxmszgx 10 9 fxzphjf 5 14 fxzpgyq 1 14

fxxmym 15 18 ktzd1 9 44 fxflsh 4 7
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图 6 参与各主题讨论的教师数量

教师 参 与 的 知 识 建 构 阶 段 数 量 和 讨 论 主 题 数 量 也 体 现

了一 定 的 分层 差 异 性，如 下 表 9 点 度 中 心 度 所 示，讨 论 内 容

建 构 阶 段 分 布 较 广 的 教 师 依 次 为 fxmswh （9）、fxmswyz（9）、
fxdgfyh（8）、fxydylf（8）和 fxmszcx（8）等，这体现教师协同备课过

程中参与知识建构的跨度，跨度大的教师不仅关注知识的低阶

段分享，而且积极参与辨析、研讨和最终知识的协商与建构，而

仅局限于某 1 个或 2 个阶段建构的教师从侧面反映了其参与

的积极性、思考的深入性不足等；而参与讨论主题数量较多的

教 师 依 次 为 fxydzy（13）、fxdgzyy（12）、fxdgfyh（11）、fxmswh（10）
和 fxmswyz（10）等，这体现了教师在协同备课过程中所关注教

学问题的广度，关注教学维度多的教师可能对于教学要素考虑

较为系统和全面。特别需要注意 ktzd2 参与建构阶段单一，经分

析多为教师协同备课过程中的活动和操作支持、技术指导不足

等，而这些都将为教师协同备课顺利开展提供必要支持。

2.中介中心度分析

另一个刻画行动者个体中心度的指标是中介中心度，它

测量的是行动者对资源控制的程度。 如果一个点处于许多其

它结对两点间的捷径（最短的途径）上，该点就具有较高的中介

中心度，具有沟通各个其他节点的桥梁作用。 为了解教师在多

大程度上居于其他教师之间，对协同备课人员的 1-模矩阵（见

表 4） 采取网络中介中心度分析， 使用 UCINET 的“Network>
Centrality>FreemanBetweenness>NodeBetweenness”功 能 ，分 析

结果如下表 10 所示，从中可以看出，中介中心度非零的教师

共有 12 名，这 12 名人员（包括 2 名活动组织人员）在协同备

课过程中与多组教师进行互动和讨论， 在与其他组互动后再

回到本组，起到信息中介者、传递者的作用，打破了组内禁锢，
间接将相关教学设计思想、教学方法进行了传递，促进沟通。

（三）凝聚子群分析

凝聚子群的研究目的是为了揭示群体内部的子结构，通

常研究交流过程是否出现小团体现象，建立在互惠性基础上

的凝聚子群主要是派系（cliques）。 在 UCINET 软件中，选择菜

单 项“Network>Subgroup>Cliques”对 协 同 备 课 人 员 1-模 矩 阵

（见表 4）进行计算，结果发现在协同备课中形成 9 个派系。 这

说明 教 师在 协 同 备 课 过 程 中， 形 成 9 个 交 互 较 为 密 切 的 小

组， 结合协同备课人员往来中介中心度来看，fxdgzyy、fxydzy、
fxydylf、fxzpyj、fxzpxy、 ktzd1、ktzd2 等 中 介 度 较 高 的 参 与 者 都

存在多个小组中，列示如下，并见图 7。
1:fxdgzyyfxydzyfxzpxyfxzpyj ktzd1 fxljwcyfxljwqfxljzrhfxzp-

hjffxljfwhfxljly ktzd2 fxljxjfxydwgxfxzpgyq
2:fxdgzyyfxydylffxydzyfxdgfyhfxzpxyfxzpyj ktzd1 ktzd2
3:fxdgzyyfxydylffxydzyfxdgfyhfxxmymfxzpxyfxzpyjfxbyzhktzd1
4 : fxdgzyyfxydylffxydzyfxmswyzfxmswhfxdgfyhfxmslxdfxmsz -

fxmszgx ktzd1
5:fxdgzyyfxydylffxydzyfxmswyzfxdgfyhfxxmymfxbyzh ktzd1
6:fxydylffxthzhfxydzyfxfgwynfxdgfyhFXTHzxx ktzd1 fxfgcm-

fxfgyl ktzd2 fxthzfr
7:fxydylffxydzyfxdgfyhfxxmymfxzpxyfxzpyjfxbyzpfxbyzhktzd1

fxxmyxzFXXMzttfxthzfr
8:fxydylffxydzyfxdgfyhfxzpxyfxzpyj ktzd1 ktzd2 fxthzfr
9:fxdgzyyfxydylffxydzyfxmswyzfxxmymfxbyzhfxflwyjfxflsh

图 7 协同备课人员派系图

（四）“核心—边缘”与“分派”（factions）分析

“核心”是一个聚类，是经常“共现”（co-occurring）的行动

者和事件的聚类。 在 2-模关系矩阵中，“核心”包括一系列行

动者的分区和事件分区构成，行动者分区与事件分区中的每

个 事件 紧 密 联系 在 一 起，同 时，事 件 的 分 区 也 与 核 心 分 区 中

的行动者紧密联系在一起，“边缘”则相反。 [21]“核心-边缘”分

析帮 助 我 们从 二 维 角 度 去 了 解 教 师 在 建 构 阶 段 和 备 课 主 题

Theory Front

表 9 “协同备课人员-知识建构阶段”与“协同备课人员-教学维度”
二部矩阵点度中心度

节点

建
构
阶
段

教
学
维
度

节点

建
构
阶
段

教
学
维
度

节点

建
构
阶
段

教
学
维
度

节点

建
构
阶
段

教
学
维
度

fxmswh 9 10 fxxmym 6 10 fxxmyxz 5 7 fxljzrh 3 2

fxmswyz 9 10 fxbyzp 6 8 fxflwyj 4 6 fxljfwh 2 2

fxdgfyh 8 11 FXTHzxx 6 8 fxljwq 4 6 fxljly 2 2

fxydylf 8 10 fxzpyj 6 8 FXXMztt 4 5 fxthzfr 1 2

fxmszcx 8 7 fxbyzh 6 7 ktzd1 4 4 fxljxj 1 1

fxzpxy 8 7 fxljwcy 6 4 fxzphjf 3 5 fxydwgx 1 0

fxydzy 7 13 fxdgzyy 5 12 fxfgcm 3 4 fxzpgyq 1 0

fxmszgx 7 6 fxmslxd 5 9 fxflsh 3 3 ktzd2 1 0

fxthzh 6 10 fxfgwyn 5 7 fxfgyl 3 2

表 10 协同备课人员网络中介中心度

节点 Betweenness 节点 Betweenness 节点 Betweenness

fxydzy 89.250 fxdgfyh 23.967 fxthzfr 7.345

ktzd1 69.117 ktzd2 22.578 fxxmym 4.905

fxdgzyy 39.202 fxzpxy 16.315 fxbyzh 4.905

fxydylf 35.100 fxzpyj 16.315 fxmswyz 4.000
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维 度 上 的 聚 类 情 况 。 利 用 UCINET 中 的 “Network>2-Mode
Networks>Categorical/Core-Periphery”对“协 同 备 课人 员-知 识

建构阶段”“协同备课人员-教学维度” 2-模关系矩阵分别进

行分析。 分析结果显示，“协同备课人员-知识建构阶段”2-模

多值矩阵的最终拟合值为 0.721 （0 意味着拟合度低，1 意味

着完 全 拟 合）， 核 心 由 fxdgzyy、fxydylf、fxthzh、fxydzy、fxfgwyn、
fxmswyz、fxmswh、fxmslxd、fxxmym、2B、2D 和 3D 组成， 这表明

从 知 识 建 构 角 度 ， 这 些 教 师 围 绕 着 方 案 提 出 自 己 的 疑 问

（2B）、提出替代教学设计（2D）和最后修订达成一致（3D）构成

“核心”分区。 “协同备课人员-教学维度”2-模多值矩阵的最

终拟合值为 0.580，核心由教学重难点、课堂导入、课文处理、
朗 读 指导、 识 字 策略、 拓 展 阅 读、 问 题 设 计、 写 话 策 略 和

fxdgzyy、fxydylf、fxthzh、fxydzy、fxfgwyn、fxmswyz、fxmswh、fxdg
fyh、fxxmym、fxmslxd、fxzpxy、fxmszcx、fxzpyj 组成， 这显示了从

讨论主题角度“核心”分区的组成情况。
此外，还可以结合另一类块模型方法“分派”（factions）开

展 分 析，分 派 分 析的 目 的 是将 一 个 网络 进 行 分 组，找 到 其 中

互斥的组别，从而使群体内部的密度高，群体之间的密度低。
将“协 同备 课 人 员-教 学 维 度”2-模 表 二 值化 处 理，再得 到 其

二部 矩 阵，利用 UCINET “Networks>Subgroups>Factions”的 功

能进行分析，如组别选项“Number of blocks”选择“8”，则得 到

如 下分 成 8 组 的结 果，这 为如 何 打 破 既 有 组 别、根 据 教 师 关

注的主题确定分组开展后续深入研讨提供了参考。 注意这和

派系（cliques）分析不同，“分派”（factions）分析中，每位参与者

只能被分配在一个小组中。

1: fxmswhfxljzrhfxzphjffxfgylfxljly 教学目标 _ 课前任务设

计 _ 拓展阅读

2: ktzd1 FXXMzttfxljxjfxzpgyq 创新思维 _ 信息 技 术 应用

_ 语言训练

3: fxydylffxxmymfxzpxyfxbyzpfxthzfr 问题设计 _ 写字策略

_ 作业设计

4: fxthzhFXTHzxxfxbyzhfxfgcm 教学活动调整 _ 课堂导入

_ 识字策略 _ 学习方式

5: fxdgzyyfxydzyfxdgfyhfxflwyj 板书 设 计 方 案 编 写 _ 教 师

_ 语言设计 _ 课文处理

6: fxmswyzfxmslxdfxzpyjfxmszgxfxljwq 教学 模 式 _ 朗 读 指

导 _ 写话策略

7: fxfgwynfxmszcxfxljwcyfxflsh 教材 分 析 _ 教学 目 标 一二

_ 课时分配 _ 教学重难点

8: fxxmyxzfxljfwh ktzd2 fxydwgx 课 后 拓 展 _ 评 价 策 略 _
学习者特征分析

五、讨论与小结

（一）网络协同备课促进教师群体知识协同建构

通过 网 络 分析 可 见，围 绕 网 络 设 计 方 案 的 协 同，教 师 之

间 形 成了 较 为 密切 的 关 系，进 一 步 规范、明 确 了 教 学 设 计 要

素 的 格 式，通 过 教 学 活 动 设 计、多 种 教 学 策 略 的 分 享（如 1B
阶段），教 师 积累 了 更 多识 字、问 题设 计、情 景 导 入 等 教 学 策

略 方法，这 体 现了 群 体 知识 的“同 化”过 程，而 对 具 体 方 案 进

行辨析（如 2A、2B 阶段）、提出替代假设（如 2D 阶段）和 形成

最终 协商 建 议（如 3D 阶 段），对 具体 教 学 情景 如 何 选择 最 有

效的 教 学 策略 有 了 更深 入 的 了 解， 这 又 体 现 了 群 体 知 识 的

“顺应”过 程，教师 对 于 已知 教 学 策略 应 用 情 景、应 用 方 式 形

成了新的认识和看法。

（二）鼓励打破组内交流局限，后续增强组间交互

分布式认知理论认为认知不仅存在于个体内，而且分布

在个体之间以及相应的活动、工 具产 品 间。 [24]协同 备 课 过程

中，应 通过 活 动 设计 和 激 励措 施，让 教 师 间 能 够 进 行 充 分 的

交 流，这种 交 流 和协 同，应 该不 仅 存 于组 内，而 且 存 于 组 间。
结合 1-模网络、2-模网络的网络结构图、中心度、凝聚子群分

析，发现仅有 12 位参与者参与了不止一个方案的协同，共形

成了 9 个派系，跨越多个小组，而剩下的 23 位参与人员则仅

仅是参与组内的交流。 因此，后续研究中，应该引导更多教师

打破组内限制，增强组间交互。

（三）根据教师参与的分层特点，进行个性化指导和角色

分配

结合 中 心 度、凝 聚 子 群 等 分 析，发 现 教 师 参 与 协 同 过 程

中 体 现了 分 层、权力 不 均 的特 点，这 种 差 异 不 仅 体 现 在 参 与

讨 论 协同 的 次 数、与 之 发 生互 动 的 协 同 人 员 数 量 上，还 体 现

在 教 师参 与 知 识协 同 建 构的 阶 段、 所 涉 及 的 讨 论 主 题 范 围

等。 通过网络分析，可以对每位参与协同备课活动的教师特

点 形 成更 为 立 体、全 面 的 认识，一 方 面 可 以 作 为 每 位 协 同 备

课 参 与人 员 的 参与 度 和 贡献 度 的 评价 依 据 ，另 一 方 面，为 后

续 提 供个 性 化 的指 导 和 教研 活 动 中 的 角 色 分 配 等 提 供 了 依

据。 中介中心度高的教 师，如 fxydzy、fxdgzyy、fxydylf、fxdgfyh、
fxzpxy、fxzpyj 则 类 似课 题 组 织人 员 ktzd1 和 ktzd2 的 作 用，参

与广、主动性强，起到信息中介的作用，可以作为后续协同备

课或网络教研的组长候选人。 而类似 fxmswyz、fxthzh、fxfgwyn、
fxmswh 点度中心度较高的人员， 虽然主要局限在组内交流，
但能同时关注较多教学问题并能进行较深入的交流，可以作

为协同备课的核心参与人员，并在后期鼓励其多参与组间互

动。 而对无论是参与频次、教学关注点还是协同知识建构阶

段都表现比较匮乏的边缘参与教师，则需要后期进行重点的

关注，通过个别访谈、问卷调查等方式了解其背后原因，并根

据其需要提供技术、认知、群体动力等方面的支持。

（四）确定研讨空白点和形成相关研究兴趣小组

通过 “协同备课人员-教学维度”、“协同备课人员-知识

建构阶段”二部矩阵点度中心度和“核心-边缘”分析，能得出

这次协同备课过程中教师的关注建构阶段、关注的教学要素

和教学问题，以及教师协同备课中的核心分区。 从中可以看

出，课 堂 学 习方 式、信 息技 术 应 用、创 新 思 维 培 养、评 价 策 略

等重要主题教师鲜有涉及，后续在协同备课过程中应该引导

教师有意识地多加关注， 协同备课阶段基本上对于第四、第

五阶段的知识建构没有涉及， 应该引导教师在教学实践后，
结合实践反思对方案进行评论和修订。 而“分派”（factions）分

析则为后续区域开展相关教研，打破学校限制组成具有相同

兴趣的研究小组提供参考。
通过上述分析可见， 本研究从社会网络分析的角度，对

教师区域网络协同备课中的社会网络分析 荨荨理论前沿
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【Abstract】 Social network analysis has been attracting more and more people’s attention especially in the areas of CSCL and
teacher’s profession development. Based on related literatures, it is found that previous studies mainly focus on 1-mode social network
analysis. However, in this study, 1-mode and 2-mode social network analysis are applied synthetically to analyse the online interac-
tion among 33 Chinese teachers from 10 different primary schools in Feixi county, Anhui province aiming to develop their instructional
design skills by focusing on collaborative lesson planning supported by learning cell system. By analyzing the structure, centrality, co-
hesive subgroups, core/periphery and fraction of the social network, the characteristics of participation in collaborative lesson planning
are revealed at both group level and individual level, especially the features of individual participation, knowledge co-construction
stage distribution and the topic distribution. Finally, some conclusions and suggestions are provided for designing follow-up online col-
laborative lesson planning activities.
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肥西 县 部 分语 文 教 师的 协 同 备课 方 案 的协 同 情 况 进 行 了 深

入分析，分析结果为后续研究的实施提供了依据。 同时，本文

尝试将 1-模关系矩阵和 2-模关系矩阵结合起来分析， 具有

一定的探索、创新意义。 而后续如何在协同备课中进行角色

分 配，如何 利 用 社会 网 络 分析 法，将 教师 网 络 协同 备 课 情 况

和 教 师实 践 参 与情 况 进 行比 较 分 析则 是 具 有 挑 战 性 的 进 一

步研究内容。
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